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Copyright Notice

Copyright 2008-2009 Ashtech. All rights reserved.

P/N 631629-01 rev F, January 2010

Trademarks

All product and brand names mentioned in this publica-
tion are trademarks of their respective holders.

FCC Notice

ProMark 500 Receiver complies with the limits for a 
Class B digital device, pursuant to the Part 15 of the 
FCC rules when it is used in Portable Mode. See Note be-
low related to Class B device.

Class B digital devices NOTE: This equipment has been 
tested and found to comply with the limits for a Class B 
digital device, pursuant to Part 15 of the FCC Rules. 
These limits are designed to provide reasonable protec-
tion against harmful interference in a residential instal-
lation. This equipment generates, uses, and can radiate 
radio frequency energy and, if not installed and used in 
accordance with the instructions, may cause harmful in-
terference to radio communications. However, there is 
no guarantee that interference will not occur in a partic-
ular installation. If this equipment does cause harmful 
interference to radio or television reception, which can 
be determined by turning the equipment off and on, the 
user is encouraged to try and correct the interference by 
one or more of the following measures:

– Reorient or locate the receiving antenna.

– Increase the separation between the equipment 
and receiver.

– Connect the equipment into an outlet on a circuit 
different from that to which the receiver is connect-
ed.

– Consult the dealer or an experienced radio/TV tech-
nician for help.

When ProMark 500 is used with an external power sup-
ply or connected to an external device using the USB 
port, it complies with the limits for a Class A digital de-
vice, pursuant to the Part 15 of the FCC rules. See Note 
below related to Class A device.

Class A digital devices NOTE: This equipment has been 
tested and found to comply with the limits for a Class A 
digital device, pursuant to Part 15 of the FCC Rules. 
These limits are designed to provide reasonable protec-
tion against harmful interference when the equipment is 
operated in a commercial environment. This equipment 
generates, uses, and can radiate radio frequency energy 
and, if not installed and used in accordance with the in-
struction manual, may cause harmful interference to ra-
dio communications. Operation of this equipment in a 
residential area is likely to cause harmful interference in 
which case the user will be required to correct the inter-
ference at his own expense.

Remark: Any changes or modifications not expressly ap-
proved by Ashtech, could void the right for user to oper-
ate the equipment.

RF Safety Exposure To Radio Frequency Energy (SAR)

Radio transmitting devices radiate Radio Frequency (RF) 
energy during its operation. RF energy can be absorbed 
into the human body and potentially can cause adverse 
health effects if excessive levels are absorbed. The unit 
of measurement for human exposure to RF energy is 
"Specific Absorption Rate" (SAR).

The Federal Communications Commission (FCC), Indus-
trie Canada (IC), and other agencies around the world 
have established limits that incorporate a substantial 
safety margin designed to assure the safety of all persons 
using this equipment. In order to certify this unit for sale 
in the US, Canada and Europe this unit has been tested 
for RF exposure compliance at a qualified test laboratory 
and found to comply with the regulations regarding ex-

posure to RF Energy. SAR was measured with the unit 
(GSM Module) transmitting at its maximum certified RF 
power. Often, however, during normal operation the unit 
(GSM Module) will transmit much less than maximum 
power. Transmit power is controlled automatically and, 
in general is reduced as you get closer to a cellular base 
station. This reduction in transmit power will result in a 
lower RF energy exposure and resulting SAR value.

FCC and CE UHF Safety Statement

The different versions of the UHF Transmitters are FCC 
and CE compliant.

In order to comply with FCC and CE RF exposure safety 
guidelines as body-worn, normal use of unit, the follow-
ing must be followed:

A distance of AT LEAST 10 feet (3 m) of separation be-
tween the users body and the unit (UHF Transmitter). 
This distance has been defined taken into account the 
FCC and CE Requirements and the worst output power 
configuration.

Do NOT use the device in a manner such that it is in di-
rect contact with the body (e.g. on the lap). Such use will 
likely exceed FCC RF safety exposure limits. See 
www.fcc.gov/oet/rfsafety/ for more information on RF ex-
posure safety.

Replacing Radio Transmitter Power Fuse

Radio transmitter P/N 800986-x0 is protected by a 4-A 
fuse inserted in the data/power cable. This Y-shaped ca-
ble is used to connect the transmitter to the ProMark 
500 receiver via a 7-pin connector, and to the power bat-
tery.

Should you have to replace this fuse, please get a spare 
fuse, 4 A, fast acting, ATO type, and then do the follow-
ing:

– Unplug the battery end of the data/power cable

– Open the fuse holder located along the data/power 
cable

– Extract the damaged fuse

– Insert the new fuse and then push the holder lid 
back into place

– Connect the data/power cable back to the battery.

Where to Find Information

This manual is designed to guide you through the basic 
ProMark 500 procedures. You can find additional infor-
mation in the ProMark 500 Reference Manual, also pro-
vided on the ProMark 500 CD.

Warranties

Refer to the ProMark 500 Reference Manual.

Warning

Because Ashtech is migrating its products and publica-
tions gradually from the former to the new brand, there 
may still be some references to the former brand. During 
that transition, please keep in mind that, as from Janu-
ary 2010, the only valid name for our brand is 
“Ashtech”.



Table of Contents

E
n
gl

is
h

Introduction........................................................................................1
What is ProMark 500?............................................................1
Scope of this Guide ...............................................................1

System Components Overview..............................................................2
Basic Supply.........................................................................2
Accessories, General Purpose..................................................2
Communication Modules and Associated Antennas ...................3
Base Accessories ...................................................................4

Equipment Description & Basic Functions.............................................5
Front Panel View ...................................................................5
Indicators & Controls .............................................................5
Bottom View..........................................................................6
Battery, Connectors & Module.................................................7
Antenna Characteristics..........................................................9
Special Button Combinations..................................................9

Display Screens ................................................................................10
Power-On Screen .................................................................10
General Status Screen..........................................................10
Memory Screens ..................................................................12
Receiver Identification Screen ..............................................13
Position Computation Screen ................................................13
Screen Backlight .................................................................14
Data Transfer Screen ...........................................................14

Charging Batteries Before Use ...........................................................15
Removing the Battery from the ProMark 500..........................15
Charging the Battery ............................................................15
Inserting the Battery in the ProMark 500 ...............................16

RTK Base Setup ................................................................................17
Prerequisites .......................................................................17
U-Link TRx .........................................................................18
Radio P/N 800986 ..............................................................19
PacCrest Radio Link.............................................................20

RTK Rover Setup ...............................................................................21
Prerequisites .......................................................................21
Radio Link ..........................................................................21
GSM/GPRS Connection ........................................................21

Getting Started With FAST Survey.......................................................22
Registering as a FAST Survey User ........................................22
Creating a New FAST Survey Job...........................................23
How FAST Survey Interfaces With Your Equipment Via Blueto..24
Running FAST Survey on a MobileMapper 6
Used as a Field Terminal......................................................26
Running FAST Survey on a ProMark3 Used as a Field Terminal29

RTK Base Configuration .....................................................................33
Prerequisites .......................................................................33
Set Manufacturer & Model ...................................................33
Check/Change Bluetooth Connection .....................................33



E
n
glish
Set Receiver Parameters.......................................................34
Set Data Link .....................................................................34
Load Configuration to the Base .............................................37
Set Base Position ................................................................37

RTK Rover Configuration ................................................................... 38
Prerequisites .......................................................................38
Set Manufacturer & Model ...................................................38
Set Bluetooth Connection .....................................................38
Set Receiver Parameters.......................................................39
Set Data Link .....................................................................39
Load Configuration to the Rover ............................................42
Check that a “Fixed” Solution is Now Available ......................42

RTK Surveying .................................................................................. 45
Uploading Stakeout Points to the Field Terminal.....................45
Staking Out Points...............................................................45
Logging Points.....................................................................48
Downloading RTK Points to GNSS Solutions...........................49

Logging Raw Data ............................................................................. 50
Introduction ........................................................................50
Raw Data Logging Methods...................................................50
Downloading Raw Data.........................................................51
Deleting Raw Data Files .......................................................53

Base/Rover Configuration Memo ........................................................ 54

Bluetooth Manager Module125



E
n
g
li
sh

1

Introduction

What is ProMark
500?

Congratulations! You have just acquired the latest dual-
frequency ProMark 500 GNSS Surveying System from 
Ashtech!
GNSS has revolutionized control surveys, topographic data 
collection and construction surveying. Purchasing the right 
tools for a professional job is essential in today's competitive 
business environment. Learning to put these tools to work 
quickly and efficiently will be the focus of the present 
manual.
Compared to its predecessors, ProMark 500 is more compact 
and lightweight while integrating more technology, such as 
the exclusive BLADE™ algorithms and multi-constellation 
(GPS+GLONASS+SBAS) capabilities.
In addition, because it’s easy to use, you will be able to focus 
on your job and forget almost everything about the technical 
aspects of your equipment. No more cables, no more clip-on 
modules: ProMark 500 will be the reliable tool you are 
expecting for all your GNSS survey operations!

Scope of this
Guide

This guide is designed to help you rapidly familiarize yourself 
with your new equipment. For the sake of conciseness, only a 
selection of the many ProMark 500 and FAST Survey 
functions are presented in this guide.
Most notably, in the RTK surveying section, only the use of 
radios is fully described in the implementation of the data 
link. The other solutions are only outlined. For a full 
description of these solutions, refer to the ProMark 500 
Reference Manual.
Likewise, in the Logging Raw Data section, the assumption is 
made that raw data logging takes place simultaneously with 
the RTK field operations, which means the setup and 
configuration of the equipment is as described in the RTK 
surveying section. In fact, post-processed surveys can be 
conducted with ProMark 500 using optimized setups and 
configurations for static, Stop&Go and kinematic surveys. 
These are also discussed in the ProMark 500 Reference 
Manual.
Lastly, this guide only introduces a couple of FAST Survey 
functions, which are “Stake Points” and “Store Points”. For 
a detailed and comprehensive description of all the FAST 
Survey functions, refer to the FAST Survey Reference Manual.
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System Components Overview

The tables below provide an overview of the different key 
items composing the ProMark 500. 
Depending on your purchase and based on the type of survey 
you wish to perform, you may only have some of the listed 
items. Please refer to the packing list for an accurate 
description of the equipment that has been delivered to you.

Basic Supply

Accessories,
General Purpose

Item Part Number Picture

ProMark 500 GNSS receiver with 
standard accessories

990596

7.4 V-4.4 Ah Li-ion Battery Pack 
(rechargeable)

111374

ProMark500 User Documentation 
CD

501503

Item Part Number Picture
AC/DC Power Supply Kit (includes 
external AC adapter, battery char-
ger and cable extension for power-
ing ProMark 500 directly from the AC 
adapter)

802064

USB Device Cable (short).
Makes ProMark 500 a USB host.

702103

USB Host Cable (long)
Makes ProMark 500 a USB device.

702104

HI Measurement Tool 111146
2
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Communication
Modules and

Associated
Antennas

Vertical Antenna Extension 103717

Field bag 205923

Optional carrying case, rigid, for 
base/rover system

206215

Item Part Number Picture

Item Part Number Picture

U-Link TRx,
12.5-kHz channel 
bandwidth

Transmitter:
802080-10 (0.5/2/4W; 410-430 MHz)
802080-30 (0.5/2/4W; 430-450 MHz)
802080-50 (0.5/2/4W; 450-470 MHz)
Repeater:
802106-10 (0.5/2/4W; 410-430 MHz)
802106-30 (0.5/2/4W; 430-450 MHz)
802106-50 (0.5/2/4W; 450-470 MHz)
Each P/N includes a whip antenna, 
and an antenna bracket. The Y-
shaped power/data cable is an inte-
gral part of the transmitter (no con-
nector).

Picture of 
transmitter 
with its cable

Radio
Transmitter,
12.5-kHz channel 
bandwidth

800986-10 (0.5/4W, 410-430 MHz)
800986-30 (0.5/4W, 430-450 MHz)
800986-50 (0.5/4W, 450-470 MHz)
Each P/N includes a whip antenna, 
an antenna bracket and a Y-shaped 
data/power cable (P/N 730476).

Picture of 
transmitter 
alone

Pacific Crest 
Transmitter,
25-kHz channel 
bandwidth

110972-10 (35 W, 410-430 MHz)
110972-30 (35 W, 430-450 MHz)
110972-50 (35 W, 450-470 MHz)
Each P/N includes a whip antenna, 
an antenna bracket and an OEM Y-
shaped data/power cable.

Picture of 
transmitter 
alone
3
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Base Accessories

Radio receiver kit 
(includes radio 
module, whip 
antenna and 
small parts)

U-Link Rx:
802083-10 (410-430MHz, 12.5 kHz)
802083-30 (430-450 MHz, 12.5 kHz)
802083-50 (450-470 MHz, 12.5 kHz)
PacCrest:
802068-10 (410-430 MHz, 12.5 kHz)
802068-15 (410-430 MHz, 25 kHz)
802068-30 (430-450 MHz, 12.5 kHz)
802068-35 (430-450 MHz, 25 kHz)
802068-50 (450-470 MHz, 12.5 kHz)
802068-55 (450-470 MHz, 25 kHz)

Quad-band GSM 
antenna

111397

Item Part Number Picture

Item Part Number Picture
External DC 
Power Cable for 
Receiver (fuse 
included)

730477

Transmitter Data/
Power Cable

730476
4
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Equipment Description & Basic Functions

Front Panel View

Indicators &
Controls

Power button
To turn on the ProMark 500, hold the Power button pressed 
until the power LED lights up.
To turn off the ProMark 500, hold the Power button pressed 
until the “Magellan Professional” screen is displayed. Then 
release the button and wait until the ProMark 500 shuts 
down.

Power LED
This indicator is on when the ProMark 500 is on, and off 
when it is off.

Display Screen
The display consists of a 128 x 64-pixel, 1.5-inch 
monochrome yellow screen using organic LED technology 
(OLED). It is oriented slightly downwards so the screen can 
easily be read when the ProMark 500 is installed on top of a 
range pole. 
Used in conjunction with the Scroll button, the display screen 
allows you to view different pages of information. See Display 
Screens on page 10 for a detailed description of the 
information available from this screen.

Power Button

Log Button Scroll Button

Power LED

Display Screen
5
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After a few seconds of inactivity (i.e. Scroll button idle), 
screen luminosity turns from high to low level.

Scroll button
Press this button shortly to scroll through the different pages 
of information viewed on the screen.
If an alarm is reported on the display screen, a short press on 
the Scroll button will acknowledge the alarm. The Scroll 
button will recover its display scrolling function only after all 
the alarms have been acknowledged this way.
Another function of the Scroll button is to re-activate the 
screen backlight after the latter has automatically been 
turned off. The Scroll button is also used in the firmware 
update procedure.

Log Button
Press this button briefly to start recording raw data on the 
selected storage medium.
Another short press on this button will immediately stop raw 
data recording.

Buzzer
The internal buzzer will sound an alarm whenever a warning 
message is reported on the screen. The buzzer will beep until 
you acknowledge the warning message by pressing the Scroll 
button. 

Bottom View

5/8”  adaptor Battery
Compartment

GSM Antenna
Radio Antenna

DC Power Input

RS232/422 port
(port A)

Radio module

Bluetooth (port C)

Front Panel

USB Port
6
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Battery,
Connectors &

Module

Battery Model & Battery Compartment

The battery used in the ProMark500 is a 7.4-V DC - 4400 
mAh rechargeable battery. It is a standard model used in 
many camcorders.
The battery is housed in a battery compartment accessible 
from underneath the ProMark 500. The compartment door 
can be removed using a coin to release the two quarter-turn 
screws.

DC Power Input
A three-contact, female connector (Fischer type) allowing the 
ProMark500 to be powered from either the provided AC 
adapter (connect the cable extension between ProMark 500 
and the end of the AC adapter output cable), or an external 
9- to 28-V DC battery through cable P/N 730477 (cf. base 
configuration with radio).

GSM Antenna
A coaxial female connector (SMA type) allowing you to 
connect a GSM whip antenna to the ProMark 500.

Radio Antenna
A coaxial female connector (TNC type) allowing you to 
connect a radio whip antenna to the ProMark 500. This 
connector is available only if the ProMark 500 has been fitted 
with a radio module.

Radio Module
A module allowing ProMark 500 to receive and process 
corrections from a base. When a radio module is used, a radio 
antenna must be connected (see above). When no radio 
receiver kit is delivered, a single compartment door is 
provided instead, with no connector on it.
7
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USB Port
A nine-contact female connector (Fischer type). Depending 
on how it is configured, the USB port can be used in two 
different ways:
1. For a USB host such as a mass storage device. In this 

case, you should use the special adaptor cable provided 
(P/N 702103) to attach the USB key to the ProMark 500. 
This configuration can be used to log raw data on the USB 
key or upgrade the ProMark 500 firmware from the files 
stored on the key.

2. For a USB device allowing ProMark 500 to be seen as a 
disk from the computer connected to this port. In this 
configuration, files can be transferred between the 
ProMark500’s internal memory and the computer using 
the USB cable provided (P/N 702104).

RS232/422 Serial Port
A seven-contact female connector (Fischer type) allowing you 
to connect the ProMark 500 to an external device via an 
RS232 or RS422 serial line (default: RS232), as explained 
in the ProMark 500 Reference Manual.

Bluetooth Device
An integrated Bluetooth module allowing the ProMark 500 to 
communicate with a Bluetooth-enabled field terminal 
through a wireless connection.
8



E
n
g
li
sh
Antenna
Characteristics

The diagram below gives the dimensional parameters of the 
ProMark 500 antenna required for the system to determine 
the true height of the antenna from the measured value 
obtained using one of the standard height measurement 
methods, i.e. slant or vertical.

The height mark allows you to hook the measure tape onto it 
so you can unroll the tape down to the survey mark and read 
the slant height measurement directly on the tape.

Special Button
Combinations

• With the ProMark 500 OFF, pressing the Power, Log and 
Scroll buttons simultaneously for a few seconds will 
restore all the factory settings. Always use this 

combination after changing the radio module. This allows 
the receiver to recognize the new module.

• With the ProMark 500 OFF and a USB key connected, 
pressing the Power and Scroll buttons simultaneously for 
a few seconds will cause the ProMark 500 to start a 
firmware upload process. If there is no USB key 
connected or the key does not contain a firmware upgrade, 
then the process will abort after a few seconds.
Because data has to be decompressed on the USB key 
during upgrades, the USB key must be unlocked, with at 
least 10 MBytes of free memory, before starting the 
upgrade.

These button combinations are summarized in the table 
below:

86
.2

 m
m

10
1.

8 
m

m
L1

L2

Antenna Radius
= 98 mm

SHMP Offset

=40 mm

Height Mark

Button 
Combination

ProMark 500 
State

Function

Power+Log+Scroll OFF Restores Factory Settings.

Power+Scroll OFF Initiates firmware update from USB key.
9
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Display Screens

If you press the Scroll button several times, you will see the 
following displays successively.

Power-On Screen When you power on the receiver, the Magellan Professional 
logo appears on the screen. It is displayed until the receiver 
has completed its auto-test (this takes about 30 seconds).

Then the General Status screen is displayed. 

General Status
Screen

An example of General Status screen is shown below.

This screen displays the following information:

• : Satellite icon [1] (always displayed).
• Number of satellites tracked [2].
• Position solution status [3]:

– NONE: Position not available
– AUTO: Autonomous GPS position
– DGPS: Differential GPS position
– S DGPS: SBAS Differential GPS position
– FLOAT: Float solution
– FIXED: Fixed solution (RTK is operational)
– BASE: This receiver is configured as a base.

[1]

[9] [10] [11] [12] [13]

[2] [3] [4]

[5]

[6]

[8]

[7]
10
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• Number of satellites used [4]: Number of satellites used 
in the position processing, regardless of the current 
position solution status.

• : Data link icon [5]. This icon is displayed only when 
corrections are received and at least a float solution is 
available.

• Age of corrections [6], in seconds. This value is displayed 
only when corrections are received. No age of corrections 
is displayed in S DGPS mode.

• : Raw data logging icon [7]:
– Animated: Raw data logging in progress
– Fixed: No raw data logging in progress.

• Percentage of free memory in the storage medium used 
[8].

• : Battery icon [9] with visual indication of remaining 
charge. If an external power source is used (AC adapter or 
external battery), the battery icon will be animated to 
indicate battery charging in progress.

  is displayed when there is no battery in the 
compartment and the receiver is operated from an 
external power source.

• Power status [10].

• Alarm status [11].

• GSM status [12]. This may be one of the following icons:

Icon Definition
Percent 
value

Percentage of remaining battery. This indication will flash when 
the remaining energy drops below 5%.

Replaces percentage when an external power source is used.

Icon Definition
Alarm detected. Press the Scroll button to view the alarm type. 
Press it again to acknowledge the alarm, which then disappears 
from the list. Unless there is another alarm in the queue, in which 
case you will have to resume the acknowledge sequence, the 
screen then displays the memory screens.

None No alarm detected

Icon Definition
Blank GSM module turned off.
11
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• [13]: USB status and/or Bluetooth status. 

Memory Screens From the General Status screen, press the Scroll button to 
access the Memory screens. Memory screens appear 
successively (see examples) at a display rate of about five 
seconds:

Left screen:
• First line: Percentage of free space in the internal 

memory.
• Second line: Number of files currently stored in the 

internal memory.
• Third line: Percentage of free space on the USB mass 

storage device.
• Fourth line: Number of files currently stored on the USB 

mass storage device.

Right screen:
• First line: Total space occupied by the files currently 

stored in the internal memory.
• Second line: Nominal size of the internal memory.
• Third line: Total space occupied by the files currently 

stored on the USB mass storage device.

Blinking icon: GSM module turned on. Indicates signal strength 
received at current location. The higher the number of bars, the 
better the signal.
Fixed icon: GSM module turned on and initialized (ready for a 
connection). Indicates signal strength received at current location.

GSM module on line.

Icon Definition

USB port connected to active device

Bluetooth active

/
These two icons will appear successively when both the 
USB port and Bluetooth are active.

Blank USB port unconnected and Bluetooth inactive.

Icon Definition
12
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• Fourth line: Nominal size of the USB mass storage device.

About the “*” symbol:
• It can only appear at the end of the first or third line.
• Where placed, it indicates that this storage medium is 

used for data logging.

What if there is no USB mass storage device connected to the 
receiver?
• Parameters relevant to the USB key size and space used 

and available are void (three dots displayed instead).
• Number of files is forced to “0”.

Receiver
Identification

Screen

From any of the two Memory screens, press the Scroll button 
to access the Receiver Identification screen. See example 
below.

• Receiver Serial Number
• Firmware Version
• Receiver Bluetooth Identifier

Position
Computation

Screen

From the Receiver Identification screen, press the Scroll 
button to access the Position Computation screen. This 
screen displays the three geographical coordinates of the 
position currently computed by the receiver. See example 
below.

The upper line contains the same information as in the upper 
line of the General Status screen. A new press on the Scroll 
button will take you back to the General Status screen.
13
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Screen Backlight The screen backlight is automatically turned off if no key is 
pressed for 1 minute. When the backlight is off, a short press 
on the Scroll button will turn it back on. The Scroll button will 
then recover its usual functions.

Data Transfer
Screen

For more information on the screen displayed when 
downloading files, refer to Downloading Raw Data on 
page 51.
14
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Charging Batteries Before Use

Make sure the battery is fully charged for each ProMark 500 
you will be using in the field. Follow the instructions below to 
charge a battery.

Removing the
Battery from the

ProMark 500

Unless the battery has already been taken out, do the 
following:
• Put the ProMark 500 upside down.
• Remove the battery door, accessible from underneath the 

ProMark 500, by loosening the two quarter-turn screws 
(see picture) using a coin.

• Keeping one hand on the battery still in its compartment, 
put the ProMark 500 the right way up. The battery will 
then easily slide out of the battery compartment. 

Charging the
Battery

The battery charger comes with a separate universal AC 
adapter fitted with a 1.5-m output cable. The AC adapter 
includes a choice of four different, detachable plug types. 
Follow the instructions below to operate the charger.
• Choose the plug type that is suitable for your country.
• Secure that plug on the AC adapter by giving the plug the 

right orientation with respect to the adapter, then pushing 
and rotating it by about 10 degrees clockwise until you 
hear a “click”.

• Connect the cable from the AC adapter to the battery 
charger.

• Give the battery the right orientation with respect to the 
charger [1] (the battery terminals should come into 
contact with the two sets of connectors on the charger), 
15
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then push the battery against the plate and slide it forward 
[2] until it locks into place. 

• Plug the adapter into an AC outlet. Battery charging starts 
immediately.
For a low battery that’s being charged, you will first see the 
three LEDs switch on and off, one after the other, followed 
by a short period of time when none of the LEDs is on (see 
[3]).
After about two hours of charging, the MED LED will stay 
on [4]. A few minutes later, the HI LED [5], and then the 
MAX LED [6] will also stay on.

• When the three LEDs are on, this means the battery is 
fully charged and can be disconnected from the charger.

Inserting the
Battery in the
ProMark 500

• With the ProMark 500 upside down, insert the battery into 
the compartment making sure the battery has the right 
orientation (the battery terminals should come into 
contact with the two sets of connectors located at the 
bottom of the compartment). 

• Place the battery door over the battery and tighten the two 
screws, using a coin. Note that, once it is properly 
secured, the battery door pushes the battery against the 
bottom of the compartment to ensure electrical 
connection of the battery to the ProMark 500.

[1] [2]

11
2

MED MAXHI

MED MAXHI

[3]

[6]

MED MAXHI
[5]

MED MAXHI
[4]
16
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RTK Base Setup

Prerequisites • You will need a tripod and a tribrach (not provided) to 
install the base. The provided antenna extension pole 
fitted with a 5/8” male adaptor is also required in this 
configuration.

• For a long-range radio link, i.e. more than 1 mile or 1.6 
km, for which the radio antenna should be placed as high 
as possible, it is good practice to install the antenna on 
top of an antenna pole secured on a tripod (neither of 
these items is provided).

• To power the radio, you need an external 9-28 V DC (U-
Link TRx), 10-16 V DC (Radio P/N 800986-x0) or 9-16 V 
DC (Pacific Crest radio) power source. In all cases, using 
a standard 12-V DC battery is a convenient choice. In this 
configuration, the ProMark 500 can be powered either 
from the same power source (recommended), using cable 
P/N 730477, or from its internal battery.
Powering the ProMark 500 from the external battery offers 
two advantages: 
1. Operating sessions can be extended significantly.
2. The external battery operates as a trickle charger for 

the ProMark 500’s internal battery.
17
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U-Link TRx The connection diagram is as follows.

Mount the different items as shown on the picture.

ProMark 500 Base

Cable P/N 730477

Fuse (4 A)

Power RS (Port A)

External 9-28 V
DC Power Source

+

U-Link TRx
(P/N 802080-x0)
18



E
n
g
li
sh
Radio P/N 800986 The connection diagram is as follows.

Mount the different items as shown on the picture.

Radio Transmitter
(P/N 800986-x0)

ProMark 500 Base

Cable P/N 730476

Cable P/N 730477

Power RS (Port A)

Fuse (4 A)

External 10-16 V
DC Power Source

+
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PacCrest Radio
Link

The connection diagram is as follows.

Mount the different items as shown on the picture.

PDL 35-W
Transmitter

ProMark 500 Base

Pacific Crest Data/Power Cable

Radio Antenna

Cable P/N 730477

Power RS (Port A)

Fuse (4 A)

External 9-16 V
DC Power Source

+
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RTK Rover Setup

Prerequisites
• Use a range pole fitted with a 5/8” male adaptor at the 

upper end (not provided).
• If a radio link is used with the base, your rover should 

normally have been fitted with the radio module that 
matches the reception band covered by the radio 
transmitter used at the base.

• If a GPRS connection is used, your rover should normally 
have been fitted with the SIM card that will allow it to 
perform a network connection.
To connect the SIM card, first use a flat screwdriver  to 
loosen the two quarter-turn screws securing the radio 
module. Remove the module. This gives access to an 
electronic card on which you can insert the SIM card as 
shown on the picture.

Radio Link
Mount the different items as shown on the picture, including 
the ProMark 500 [1], the radio antenna [2], the range pole 
[3] and the field terminal with its mounting bracket [4].
Caution! Use of a non-metal range pole is recommended to 
maintain the performance level of the radio antenna.

GSM/GPRS
Connection

As a standard feature, the ProMark 500 incorporates a built-
in GSM modem, which means you only have to connect the 
GSM antenna if you have paid for activation of the hardware. 
Mount the different items as shown on the picture, including 
the ProMark 500 [1], the GSM antenna [2], the range pole 
[3] and the field terminal with its mounting bracket [4]. 
Caution! Use of a non-metal range pole is recommended to 
maintain the performance level of the GSM antenna.

[1]

[2]

[3]

[4]

[1]
[2]

[3]

[4]
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Getting Started With FAST Survey

Registering as a
FAST Survey User

The first time you start FAST Survey, you will be prompted to 
register your license of the software. If you do not register, 
FAST Survey will remain in demo mode, limiting each job file 
to a maximum of 30 points.

How to Register
FAST Survey registration is done via the Internet at the 
following address: 

http://update.carlsonsw.com/
decode_xml.php?reg_type=dc&prod_name=Magellan%20Fast%20Surve
y

Choose Yes to start the registration process. You will be 
required to enter the following information:
• User Name
• Company Name
• Serial Number*
• Email Address
• Phone Number
• Fax Number
• Hardware ID#1*
• Hardware ID#2*
• Reason for Install
• Registration Code*

*: Select Equip>About Magellan Fast Survey>Change Registration 
in FAST Survey to read this information.
After you submit this information, your change key will be 
displayed and emailed to the address that you submit. Keep 
this for your permanent records. You may then enter the 
manufacturer and model of your equipment.
If you do not have access to the Internet, you may fax the 
above information to (+1) 606-564-9525. Your registration 
information will be faxed back to you within 48 hours. During 
this time, you may continue to use the program without 
restriction. After you receive your Change Key, enter it and tap 
OK. You can then create a new FAST Survey job, as explained 
further.
22
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Saving your registration in the Field Terminal 
When you register FAST Survey in a MobileMapper CX, the 
code is automatically and safely saved at the end of the 
registration procedure.
With a Juniper Allegro CX, you need to perform a RAM backup 
or a System Save to be sure your authorization code will not 
be lost when you next reboot your Allegro CX. If you cannot 
find this option on the Allegro CX Start menu, then open the 
Control Panel and choose RAM backup.

Creating a New FAST Survey Job

1. Turn on the field terminal and wait until the boot 
sequence is complete.

2. Make sure the clock is set properly before starting FAST 
Survey.

3. Double-tap  to launch FAST Survey.
4. Tap the Select New/Existing Job button. This opens the 

Coordinate Files window.
5. Tap on the highlighted “crd” file name located at the 

bottom of the screen. This opens FAST Survey’s virtual 
keyboard with the file name now appearing above.

6. Using the keyboard, type in the name of the “crd” file in 
which FAST Survey will store the data you will collect 
during your job.

7. Tap . This takes you back to the Coordinate Files 
window where your file name now appears in the Name 
field.

8. Tap  again. This opens the Job Settings window, which 
consists of five different tabs on which you can set a large 
number of parameters pertaining to the job (or future 
jobs).
Only the parameters that make sense with a GNSS system 
are presented below. All other parameters should be kept 
with their default settings. 
On the System tab:
– Distance: Choose the unit in which all measured 

distances will be expressed (US Survey Feet, Metric or 
International Feet). Unless “Metric” is selected, you 
can also choose the units in which distances will be 
displayed (“Decimal feet” or “Feet and Inches”). 
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Warning! You cannot change this setting after creating 

the file!

– Angle: Choose the unit in which all measured angles 
will be expressed (degrees, minutes, seconds or grads)

– Zero Azimuth Setting: Choose the direction for which 
azimuth is arbitrarily set to 0° (North or South)

– Projection: Choose a projection from the combo box. To 
select a different projection, tap the Edit Projection List 
button. The Add Predefined button allows you to select 
an existing projection. The Add User Defined button 
allows you to create an entirely new projection. The 
selected or created projection will then be selectable 
from the combo box.

On the Stake tab:
– Precision: Choose the number of decimal places (0 to 

5) used to express the three coordinates of any 
stakeout point. “0.000” (3 decimal places) is the best 
setting to fully benefit from the precision offered by 
your equipment.

On the Format tab:
– Coordinate Display Order: Choose the order in which you 

want FAST Survey to display East and North 
coordinates (East,North or North,East).

– Angle Entry and Display: Choose the type of angle FAST 
Survey will display (Azimuth or Bearing).

9. Tap . This creates the file, closes the Job Settings 
window and takes you to the FAST Survey menu.

How FAST Survey
Interfaces With
Your Equipment

Via Bluetooth

First-Time Use
Right after you start FAST Survey and create or open your first 
job, FAST Survey will try to activate the preset connection 
(default: “Cable”) to the receiver. Because no cable is 
connected to the field terminal, a message will be displayed 
informing you that the connection failed.
Assuming your base and rover are nearby and powered on, 
follow the procedure below to perform a Bluetooth connection 
with the base.
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• Tap Equip>GPS Base.
• Tap on the Comms tab.
• Select “Bluetooth” from the Type field and “Magellan BT” 

from the Device field.
• Tap on the Configure button. This opens the Bluetooth 

Devices window.
• Tap Find Receiver. Wait until FAST Survey lists the 

Bluetooth identifiers of your base and rover. The list 
appears in a new window.

• Highlight the Bluetooth identifier corresponding to the 
base. To make sure you select the right identifier, press 
the Scroll button on the base until you display the 
Receiver Identification screen. The identifier is in the 
lower line (after the “BT:” prefix).

• Tap . This takes you back to the previous screen where 
the selected Bluetooth identifier remains highlighted in 
the list. The following actions may be performed on the 
selected receiver using the following buttons:
• Set Receiver Name: By default, the “Receiver Bluetooth 

Identifier” of the detected receiver is assigned to this 
parameter. You may use a more self-explanatory name 
to identify your base (e.g.: “MyBase”). 

• Set Receiver PIN: Do not use this button. In its default 
configuration, your equipment does not request a PIN 
code to allow a peripheral device to connect to it via 
Bluetooth.

• Delete Receiver: Removes the selected receiver from the 
list of remote receivers detected by Bluetooth. 

• Tap  to connect the field terminal to the base via 
Bluetooth and then configure the base according to your 
needs (see RTK Base Configuration on page 33).

• Later, you will establish a Bluetooth connection with the 
rover. The process will start when you tap Equip>GPS Rover 
to configure the rover. From the Comms tab, you will be 
able to access the Bluetooth Devices window and select 
the rover receiver from the list of remote receivers 
detected by Bluetooth, in the same way as you did for the 
base.
25
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Switching Between Base and Rover
During a FAST Survey session, you can quickly change the 
receiver you are communicating with (provided the receiver 
you want to communicate with is within Bluetooth range). 

The  icon located in the upper-right corner of the FAST 
Survey window allows you to change receivers. Tap on this 
icon and then:
• Select GPS Base to switch to the base,
• Or select GPS Rover to switch to the rover.

NOTE: If you examine more carefully this icon, you will see 
that it changes aspect (base or rover icon) depending on 
which receiver is currently communicating with FAST Survey.
In addition, on the Equip menu, a small check box appears in 
the icon inside either the GPS Rover or GPS Base button to 
indicate which connection is active.

Subsequent Uses
In the next sessions of FAST Survey, the software will prompt 
you to re-activate the Bluetooth connection you last 
established in the previous session, or simply work without a 
connection. If you choose the first option, FAST Survey will 
automatically re-establish the connection, provided the 
concerned receiver is still on and within Bluetooth range. 

Running FAST
Survey on a

MobileMapper 6
Used as a Field

Terminal

Principle
Unlike MobileMapper CX, MobileMapper 6 does not allow a 
Bluetooth connection to be established directly from the 
FAST Survey software running on this platform.
Instead you should first use MobileMapper 6’s Bluetooth 
Manager program to associate a COM port to Bluetooth. Then, 
from within FAST Survey, a Bluetooth connection can be 
established via the selected COM port. A non-secure 
connection is recommended.
As is already the case with other field terminals, in the 
following sessions of FAST Survey and MobileMapper 6, the 
software will simply prompt you to re-activate the last 
established Bluetooth connection.

Assigning a COM Port to Bluetooth For a Given GNSS 
Receiver
• Turn on the GNSS receiver(s) you want to communicate 

with through FAST Survey.
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• Turn on MobileMapper 6 by pressing the Power button 
located on the right side of the receiver.

• Activate Bluetooth on MobileMapper 6: On the Start 
screen, check to see if the Bluetooth status is “On” (read 
the line under the current date). If it’s already “On”, skip 
this step.
If it’s “Off”, tap on the Bluetooth icon line, then tap on 
the Bluetooth blue button to change the status 
(underneath) from “off” to “on”. Tap Done to return to the 
Start screen.

• Tap Start>Settings.
• Tap on the Connections tab.
• Tap on the Bluetooth icon. This opens the Bluetooth 

Settings window.
• Tap on Add new device... MobileMapper 6 starts searching 

for the nearby Bluetooth devices. For each device 
MobileMapper 6 detects, the Bluetooth identifier of this 
device is returned in the search window (e.g. PM_743107 
for a ProMark 500). The Refresh button can be used to 
resume the search if necessary. 

• Tap on the Bluetooth identifier corresponding to the GNSS 
receiver you want to communicate with and then tap Next.

• Because no secure connection is required, just ignore the 
Passcode field and simply tap Next.

• Tap Yes after the MobileMapper 6 beeps and a message 
appears asking you to confirm you want the ProMark 500 
to be added to the list of Bluetooth devices.

• Once again, the Enter Passcode screen is displayed. Tap 
Cancel. This opens the Partnership Settings window.

• Activate the Serial Port service: Check on the Serial Port 
option box and tap Finish.
This takes you back to the Bluetooth Settings window 
where you can now see the selected receiver as a possible 
receiver to communicate with.

• Tap on the receiver Bluetooth identifier. This re-opens the 
Bluetooth service screen where you can see the option box 
you have just enabled.

• Tap on Save. This takes you back to the previous screen, 
with the receiver Bluetooth identifier now highlighted.

• Tap on the Mode tab. Make sure the two options on this tab 
are enabled.

• Tap on the COM Ports tab.
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• Tap on New Outgoing Port. The selected Bluetooth identifier 
(corresponding to your GNSS receiver) now appears and is 
highlighted. 

• Tap on the Next button
• Choose a COM port that will be the port used by Bluetooth 

to communicate with the GNSS receiver. Ports 0 and 1 are 
reserved. Choose any of the other ports (COM2 to COM9, 
except COM3).

• Clear the Secured Connection option.
• Tap Finish.
• Tap ok.
• Tap Cancel if the MobileMapper 6 asks again for a secure 

connection through a passcode.

• Tap  to return to the Start screen.
For each new GNSS receiver you want to be able to 
communicate with, resume all the previous steps from the 
fourth step. Each time select a different COM port.

Establishing a Bluetooth Connection Through the Selected 
COM Port
• On MobileMapper 6, launch FAST Survey and open or 

create a job.
• On the Equip tab, tap on GPS Rover or GPS Base depending 

on what the GNSS receiver will be used for.
• On the Current tab, select “Magellan Navigation” as the 

manufacturer and “ProMark 500”.
• Tap on the Comms tab.
• In the Type field, select “Bluetooth”.
• In the Device field, select “Other”.
• In the Port field, select the COM port you assigned earlier 

for use by Bluetooth (COMx).
• Browse through the other tabs (Receiver, RTK) to set the 

other parameters of the receiver.

• Tap  to start the communication with the receiver. A 
beep can be heard in MobileMapper 6 when the Bluetooth 
connection has been established. The Bluetooth icon also 
appears on the display screen of the GNSS receiver.

Communicating With a Base/Rover System
For easy Bluetooth communication with a base-rover system 
from a single MobileMapper 6 running FAST Survey, you 
should assign a different COM port to the base and the rover.
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Once the connection has been made successively for each 
receiver, switching from one to the other is simply done by 
using the icon located in the upper-right corner of the FAST 
Survey window, as done with other field terminals.

Changing the COM Port for a Bluetooth Connection
To change the COM port currently assigned to a receiver, do 
the following on MobileMapper 6:
• Tap Start>Settings.
• Tap on the Connections tab.
• Tap on the Bluetooth icon. This opens the Bluetooth 

Settings window.
• Tap on the COM Ports tab. This window lists the current 

COM port settings for the detected receivers.
• Tap on New Outgoing Port (and not directly on the receiver 

Bluetooth identifier).
• Then tap on the Bluetooth identifier of the receiver for 

which you want to change the COM port. Tap Next.
• Change the COM port number and then tap Finish and ok.

Running FAST
Survey on a

ProMark3 Used as
a Field Terminal

Installing FAST Survey
• Insert an SD card into the card reader of a computer.
• On the FAST Survey CD, go to \ProMark500-ProFlex500-

ZMax\ProMark3 Controller\<Language> to find the FAST 
Survey.CAB file corresponding to the language you want to 
install.

• Copy the CAB file to the root directory of the SD card.
• Remove the SD card from the card reader and then insert 

it into the ProMark3.
• On ProMark3, double-tap Utilities and run Install FAST 

Survey.
• Make sure the FAST Survey button is checked.
• Tap on the Install button and let the ProMark3 complete 

the installation.

Note: You can only have one version of FAST Survey installed on the 
ProMark3. If the FAST Survey version for ProMark3 RTK is already 
installed on the platform, running the above instructions will 
overwrite it.

Unlocking FAST Survey
Using FAST Survey on a ProMark3 platform requires that the 
software be installed and unlocked. Unlocking FAST Survey 
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is achieved by entering a product key provided by your dealer 
following your purchase of FAST Survey for this platform.
• On ProMark3, double-tap Utilities and run Unlock FAST 

Survey.
• Type in the product key.
• Tap OK. A message will inform you that FAST Survey has 

successfully been unlocked.

Establishing a Bluetooth Connection Through a COM Port
The first time you start a new session with ProMark3 and 
FAST Survey, do the following:
• Turn on the GNSS receiver(s) you want to communicate 

with through FAST Survey.
• Turn on ProMark3 by pressing the red Power button 

located on the front panel.
• On the workspace screen, double-tap on the Settings icon.
• Double-tap on the Bluetooth Manager icon.

• Tap on  to start searching for the nearby Bluetooth 
devices. An icon appears for each detected device.

Tap on  to resume the search if no device, or not all 
devices were detected the first time. 

• Visually identify the icon corresponding to the GNSS 
receiver you want ProMark3 to communicate with (e.g. 
“PM_743107” for a ProMark 500).

• Tap and hold this icon and select Explore. This opens a 
new list showing the services attached to the remote 
device. For a ProMark 500, this can only be a serial port 
service. 

• Tap and hold the Serial Port icon and select Connect. Select 
a COM port that the ProMark3 will associate with 
Bluetooth for a connection to the GNSS receiver (three 
ports are available: COM7 to COM9).

• Tap OK. After about one second, a beep can be heard in 
the ProMark3 after the Bluetooth connection has been 
established. The Bluetooth icon also appears on the 
display screen of the GNSS receiver. A message is 
displayed indicating a successful connection with the 
GNSS receiver through the chosen port. (Note the 
presence of a plug in a green circle on the Serial Port icon 
showing that the connection has been made.)

• Tap OK to close the message window.
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• To further allow you to speed up the connection phase 
when later starting a new working session with ProMark3 
and FAST Survey, create now a shortcut to the serial port 
service. This is simply done by tapping again on the Serial 
Port icon and selecting Create Shortcut.

• Then tap OK to close the message window.

• Tap  to close the Bluetooth Manager window.

• Tap  again to close the settings window and return to 
the ProMark3 workspace screen.

Later, when you power on ProMark3 for a new working 
session, and before launching FAST Survey as explained 
below, do the following to re-establish the Bluetooth 
connection with your GNSS receiver(s): 
• Turn on the GNSS receiver(s).
• Turn on ProMark3 by pressing the red Power button 

located on the front panel.
• On the workspace screen, double-tap on the Settings icon.
• Double-tap on the Bluetooth Manager icon.

• Tap on  to display the list of existing shortcuts.
• Tap on the Serial Port shortcut icon and then select 

Connect. This instantly re-establishes the Bluetooth 
connection with your GNSS receiver through the COM port 
defined in the previous session. 

Allowing FAST Survey To Communicate Through Bluetooth
• On ProMark3, launch FAST Survey and open a job from 

the SD card, or create one on the SD card. Ignore the 
message about restoring the last Bluetooth connection 
(making a selection in this window will have no effect). 

• On the Equip tab, tap on GPS Rover or GPS Base depending 
on what the GNSS receiver will be used for.

• On the Current tab, select “Magellan Navigation” as the 
manufacturer and “ProMark 500”.

• Tap on the Comms tab.
• In the Type field, select “Bluetooth”.
• In the Device field, select “Other”.
• In the Port field, select the COM port you assigned earlier 

for use by Bluetooth (COMx). See Establishing a Bluetooth 
Connection Through a COM Port on page 30.

• Browse through the other tabs (Receiver, RTK) to set the 
other parameters of the receiver.
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• Tap  to start the communication with the receiver.

Communicating With a Base/Rover System
For easy Bluetooth communication with a base-rover system 
from a single ProMark3 running FAST Survey, you should 
assign a different COM port to the base and the rover.
Once the connection has been made successively for each 
receiver, switching from one to the other is simply done by 
using the icon located in the upper-right corner of the FAST 
Survey window, as is done with other field terminals.

Upload/Download Procedures
Using a single SD card, which you will successively insert in 
the ProMark3 and the office computer, is the easiest way to 
transfer files between the two systems. This requires that all 
the jobs created with FAST Survey in the ProMark3 be saved 
to the SD card as well.
Having said that, all the download/upload procedures used 
with a standalone ProMark3 remains the same when using 
the ProMark3 as a field terminal for ProMark 500. The only 
difference is with raw data files. If you collect these files, 
remember these are found in the ProMark 500 internal 
memory or USB stick, and not in the ProMark3 internal 
memory or SD card. 
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RTK Base Configuration

Prerequisites • Your base is properly set up and powered on. It is on its 
definitive location for the survey and the field terminal is 
located at less than 10 metres from the base. 

• Your field terminal is on, FAST Survey is running, a 
Bluetooth connection has already been configured (with 
the base; see How FAST Survey Interfaces With Your 
Equipment Via Bluetooth on page 24) and a job file is 
open.

• In FAST Survey, tap on the Equip tab and then the GPS 
Base button. A message may appear asking you to confirm 
your choice of configuring a base. Tap Yes. This opens the 
Current tab of the GPS Base window.

Set Manufacturer
& Model

• Set the Manufacturer (“Magellan Navigation”) and Model 
(“ProMark 500”) of the equipment used as the base.

Note that the  button beside the Manufacturer field 
allows you to read the following information about the 
connected receiver:
– Firmware version
– Receiver ID
– Power status
– Free memory space
– Firmware options installed.

Tap on  to return to the Current tab.

Check/Change
Bluetooth

Connection

• Tap on the Comms tab. Since the Bluetooth connection 
was performed earlier, just check that FAST Survey is 
properly configured to communicate with the base. You 
should read:
• Type = “Bluetooth”
• Device = “Magellan BT”
• Instr = should be set to the name you gave earlier to the 

base, as seen from FAST Survey Bluetooth.

Note that the Configure button next to the Device field 
allows you to return to the Bluetooth Devices window 
through which you earlier configured the Bluetooth 
connection to the base (see How FAST Survey Interfaces 
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With Your Equipment Via Bluetooth on page 24). Changes 
can be made now if necessary.

Set Receiver
Parameters

• Using the HI measurement tool provided, perform a slant 
measurement of the antenna height (recommended).

• On the field terminal, tap on the Receiver tab.
• Select the Slant option for the antenna height 

measurement.
• Tap within the Antenna Height field and enter the value you 

have just measured.
• Choose your preferred settings for Elevation Mask, SBAS, 

GLONASS and Virtual Antenna.
Using SBAS and/or GLONASS satellites will help the rover 
maintain the availability of fixed positions in those 
difficult environments where GPS alone would fail to do 
so.
The Virtual Antenna option is disabled by default. Enabling 
the virtual antenna, which is defined as the generic 
“ADVNULLANTENNA” GNSS antenna, allows all 
broadcast differential data and recorded raw data to be 
decorrelated from the GNSS antenna actually used at 
signal reception level. This may be useful when a rover 
from another manufacturer, which does not know the type 
of antenna used at the base, needs to receive RTK 
corrections from this base. 

Set Data Link • Tap on the RTK tab. This tab allows you to set the data link 
on the base side. Several configurations are possible:
1. Using a U-Link TRx device

Selecting
Magellan Radio

2. Using radio transmitter P/N 800986-x0
3. Using an external Pacific Crest radio.
4. Using the internal modem in CSD mode for a “phone 

call” type connection (Direct Dial).
5. Using the internal modem for a Direct IP connection to 

the RTDS software.
6. Using an external device connected to ProMark 500’s 

port A. The external device may be a radio transmitter 
from another manufacturer, or the local computer 
running the RTDS software.
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The table below gives all the required settings depending 
on the chosen configuration.

NOTE: All parameters between square brackets [..] are 
software-set, they cannot be changed.

• If you want to use a radio, tap on the Config button next to 
the Device field to set the radio. The table below lists the 
required and recommended settings for the three radio 
models available.

#1
U-Link TRx

#2
Radio P/N 

800986

#3
Pacific Crest 

Radio

#4
Direct
Dial

#5
Direct IP/GPRS

- RTDS

#6
External
Device

Device Magellan U-Link
Magellan 
Radio

Pacific Crest Internal GSM Internal GSM
Cable or 
Generic Device

Network [None] [None] [None] Direct Dial
“TCP/IP Direct” or
“UDP/IP Direct”

[None]

Port [A] [A] [A] [E] [E] [A]

Parity [None] [None] [None] [None] [None] [None]

Baud [38400] [19200]
9600 to 115200
User-settable

[19200] [19200]
1200 to 115200
User-settable

Stop [1 bit] [1 bit] [1 bit] [1 bit] [1 bit] [1 bit]

Message 
Type

Choose the format used to generate base data messages: ATOM, ATOM compact, RTCM V3.0, 
RTCM V2.3, CMR or CMR+, (RTCM-DGPS)

Base ID
Choose a number to identify the base. Several ranges are possible depending on the selected data 
format (0-4095 for RTCM 3.0, 0-1023 for RTCM 2.3, 0-31 for CMR and CMR+) 

Field
Model P/N 
800986-x0

U-Link TRx 
Model

Pacific Crest
Radio Model

Protocol -
“Transparent” 
recommended

“Transparent”
recommended

Channel
Choose channel 
used (channel 
No. - Frequency)

Choose channel 
used (channel 
No. - Frequency

Choose channel used 
(channel No. - Frequency)

Over the 
Air Baud

-
4800 Bd recom-
mended

“9600 Bd” recommended

Scram-
bling

- -

In a PacCrest radio trans-
mitter, enables or disables 
scrambling in this radio. 
Keep disabled for other 
radios.

Forward 
Error Cor-
rection

- -

In a PacCrest radio trans-
mitter, enables or disables 
FEC  in this radio. Keep 
disabled for other radios.
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The DSNP protocol should be used for the following 
transmitter-receiver combinations:

• If you want to use the internal modem, tap on the Config 
button next to the Device field to set the internal modem. 
The modem settings are listed in the table below:

• If you choose Network=”TCP/IP DIrect” or “UDP/IP 
Direct”, tap on the Config button next to the Network field 
and enter the IP address and port number allowing the 
connection to the RTDS software. 

• If a repeater is used within your system to extend the 
range of the UHF radios used, enable the Repeater Mode 
check box. Enabling this option causes the output rates of 
all the differential messages to be changed into an even 
value (2 sec.) in order to make them compatible with the 
use of the repeater.

Transmitter Receiver
800986-x0 U-Link Rx
800986-x0 PDL
U-Link TRx PDL
U-Link TRx TDRE (Z-Max)

Field Setting

Power
Management

“Automatic” is recommended. In Automatic, the modem is 
automatically powered when you turn on the receiver and will 
only be turned off when you turn off the receiver. In Manual, 
the modem will be powered on only when you configure the 
base.

Band
Select the frequency band used for GSM communications in 
the country where you are. 

Provider

- If you choose Network=” TCP/IP Direct” or Net-
work=”UDP/IP Direct”, choose the name of your mobile com-
munication provider in this field. There are three preset 
providers: Cingular, T-Mobile and MoviStar. If you are using 
another provider, select “Other”in this field and then tap on 
the Settings button underneath to enter the parameters of 
your provider (APN server, APN User Name and APN Pass-
word).
- If you choose Network=”Direct Dial”, ignore this field.

Pin
Enter the Pin number of the SIM card inserted in your 
ProMark 500.

Dial Mode
“Analog” is usually the right selection at the base. Please call 
your communication provider for more information.

Auto Dial Keep this box disabled for a base.
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• Tap  to load the settings to the radio or modem. This 
may take a few seconds. FAST Survey then returns to the 
GPS Base configuration window.

Load Configuration
to the Base

Now that you have browsed all the tabs in the Base 
Configuration window and set all the parameters, just tap  
to connect and load the configuration to the base. This may 
take a few seconds.

Set Base Position FAST Survey then asks you to set the base position. 
Depending on the chosen method, follow the instructions 
displayed on the screen to define this position. This 
completes the base configuration phase.
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RTK Rover Configuration

Prerequisites • Your rover is properly set up and powered on. 
• Your field terminal is on, FAST Survey is running and a job 

file is open.
• In FAST Survey, tap on the Equip tab and then the GPS 

Rover button. A message may appear asking you to 
confirm your choice of configuring a rover. Tap Yes. This 
opens the Current tab of the GPS Rover window.

Set Manufacturer
& Model

• Set the Manufacturer (“Magellan Navigation”) and Model 
(“ProMark 500”) of the equipment used as the rover.

Note that the  button beside the Manufacturer field 
allows you to read the following information about the 
connected receiver:
– Firmware version
– Receiver ID
– Power status
– Free memory space
– Firmware options installed.

Tap on  to return to the Current tab.

Set Bluetooth
Connection

• Tap on the Comms tab.
• In the Type field, select “Bluetooth”.
• In the Device field, select “Magellan BT”.
• Tap on the Configure button to access the Bluetooth 

Devices window. The window lists Bluetooth identifiers 
that correspond to the receivers found in the vicinity.

• Select the rover’s Bluetooth identifier from the list. To 
make sure you are making the right selection, press the 
Scroll button on your rover until you display the Receiver 
Identification screen. The Bluetooth identifier is shown in 
the lower line. This is the parameter you must select from 
the list.
You may give the rover a more familiar name (e.g. 
“MyRover”) using the Set Receiver Name button. 

• Tap  to connect the field terminal to the rover via 
Bluetooth. FAST Survey then returns to the GPS Rover 
configuration window.
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• Check that the rover name is now selected in the Instr 
field.

Set Receiver
Parameters

• Measure or read the length of the range pole on top of 
which the ProMark 500 is mounted.

• On the field terminal, tap on the Receiver tab.
• Select the Vertical option for the antenna height 

measurement.
• Tap within the Antenna Height field and enter the value you 

have just measured or read for the range pole length.
• Choose your preferred settings for Elevation Mask, 

Ambiguity Fixing (see table below), SBAS, GLONASS and 
Virtual Antenna.

Using SBAS and/or GLONASS satellites helps to maintain 
the availability of fixed positions in those difficult 
environments where GPS alone would fail to do so.
The Virtual Antenna option is disabled by default. Enabling 
the virtual antenna, which is defined as the generic 
“ADVNULLANTENNA” GNSS antenna, allows all 
collected data to be decorrelated from the GNSS antenna 
actually used at signal reception level. This may be useful 
if you wish to post-process the collected raw data using 
base raw data collected with a base from another 
manufacturer.

Set Data Link • Tap on the RTK tab. This tab allows you to set the data link 
on the rover side, in accordance with the base or network 
you will be working with. Several configurations are 
possible:
1. Using the internal radio receiver.
2. Using the internal modem in CSD mode for a “phone 

call” type connection with the base (Direct Dial).
3. Using the internal modem in Direct IP mode (TCP/IP 

or UDP/IP) to receive base data from either a third-
party network or the remote RTDS software.

4. Using the internal modem for a network connection 
(NTRIP or SpiderNet).
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Choice Definition

Float
Choose this option if you only need decimeter accuracy (position 
status will never go to “Fixed”).

95.0 95% confidence level
99.0 99% confidence level (default and recommended setting)
99.9 99.9 confidence level
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5. Using an external CDMA cell phone for a network 
connection (Direct IP, NTRIP or SpiderNet).

6. Using an external device (for example an external 
corrections receiver).

The table below gives all the required settings depending 
on the chosen configuration.

NOTE: All parameters between square brackets [..] being 
software-set, they cannot be changed.

• If you want to use the internal radio, tap on the Config 
button next to the Device field to set the radio receiver:

#7
Internal 
Radio

#8
Internal 
Radio

#9
Direct 
Dial

#10
Direct IP

GPRS

#11
Network,

GPRS

#12
Network,

CDMA

#13
External 
Device

Device
Magellan 
U-Link 

Pacific 
Crest

Internal 
GSM

Internal GSM Internal GSM
Data Collector 
Internet

Cable or 
Generic Device

Network [None] [None]
Direct 
Dial

“TCP/IP Direct”, 
“UDP/IP Direct” 
or “SpiderNet”

NTRIP

“NTRIP”, “TCP/IP 
Direct”, “UDP/IP 
Direct” or “Spi-
derNet”

[None]

Port [D] [D] [E] [E] [E] [A]

Parity [None] [None] [None] [None] [None] [None]

Baud [38400] [38400] [19200] [19200] [19200]
1200 to 115200
User-settable

Stop [1 bit] [1 bit] [1 bit] [1 bit] [1 bit] [1 bit]

Send 
Rover..

This option should be enabled only when working with networks offering VRS capability (NTRIP).

Field Setting

Protocol
Select “DSNP” if the radio transmitter used at the base is 
radio model P/N 800986-x0. Select “Transparent” if it’s a U-
Link TRx or a Pacific Crest radio transmitter.

Power Man-
agement

“Automatic” is recommended. In Automatic, the radio module 
is automatically powered when you turn on the receiver and 
will only be turned off when you turn off the receiver. In Man-
ual, the module will be powered on only when you configure 
the rover.

Channel Choose channel used (Channel No. - Frequency)

Squelch

The factory default setting of “High” provides maximum effec-
tive sensitivity to incoming signals.This is the preferred set-
ting.
“Medium” and “Low” sensitivity settings are available for use 
if local electrical noise or distant radio signals falsely activate 
the radio receiver. Use of these settings may reduce the 
radio range.
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Then tap  to load the settings to the radio. This may 
take a few seconds. FAST Survey then returns to the GPS 
Rover configuration window.

• If you want to use the internal GSM modem, tap on the 
Config button next to the Device field to set the internal 
modem.
The modem settings are listed in the table below:

• If you want to use a CDMA cell phone, you should first 
establish and then pair a Bluetooth link between that cell 
phone and your field terminal, using Bluetooth Manager. 

Over the Air 
Baud

Forced to “4800” with DSNP protocol; “9600 Bd” recom-
mended with other protocols; “7600 Bd” for U-Link.

Scrambling
Relevant to Pacific Crest radios only. Set this parameter as 
set at the base if it uses a Pacific Crest transmitter. For 
another radio used at the base, keep this option disabled.

Forward 
Error
Correction

Relevant to Pacific Crest radios only. Set this parameter as 
set at the base if it uses a Pacific Crest transmitter. For 
another radio used at the base, keep this option disabled.

Field Setting

Field Setting

Power
Management

“Automatic” is recommended. In Automatic, the modem is 
automatically powered when you turn on the receiver and will 
only be turned off when you turn off the receiver. In Manual, 
the modem will be powered on only when you configure the 
rover. “Automatic” is mandatory if “Auto Dial” is enabled.

Band
Select the frequency band used for GSM communications in 
the country where you are. 

Provider

- Choose the name of your mobile communication provider in 
this field. There are three preset providers: Cingular, T-
Mobile and MoviStar. If you are using another provider, select 
“Other”in this field and then tap on the Settings button 
underneath to enter the parameters of your provider (APN 
server, APN User Name and APN Password).
- If you set Network=Direct Dial, ignore this field.

Pin
Enter the Pin number of the SIM card inserted in your Pro-
Mark 500.

Dial Mode
Depending on the provider, this may be “Analog” or “Digital”. 
”Analog” is usually the right selection. Please call your com-
munication provider for more information

Auto Dial

Check this box when the data link is based on a GSM con-
nection in CSD mode between the base and the rover.
Check this box as well if you wish that after a power cycle, 
the receiver can connect automatically to the last used 
NTRIP mount point or last used Direct IP server.
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Then, you should use the Network and Dial-up 
Connections utility in your field terminal to connect it to 
the Internet. The incoming corrections will be 
automatically transferred to the ProMark 500.

• When this button is visible, tap on the Config button next 
to the Network field, for additional settings. The table lists 
all the parameters that need to be defined, depending on 
the desired operating mode.

• Tap  to load the settings to the radio or modem. This 
may take a few seconds. FAST Survey then returns to the 
GPS Rover configuration window.

Load Configuration
to the Rover

Now that you have browsed all the tabs in the Rover 
Configuration window and set all the parameters, just tap  
to connect and load the configuration to the rover.

Check that a
“Fixed” Solution is

Now Available

The rover then starts acquiring corrections data from the 
selected base. Note that the rover will automatically 
recognize the format of the received data (ATOM, RTCM2.3, 
RTCM 3, CMR, CMR+, DBEN). Do the following before 
starting your survey:
• In the Equip menu, tap on the Monitor/Skyplot button
• Read the different parameters displayed on the screen. 

You should see the HRMS and VRMS rapidly decrease 
from a few meters to less than 10 to 20 mm, while the 
position status switches from “AUTO” to “FLOAT” and 
finally “FIXED”.

Parameter
TCP/IP Direct
UDP/IP Direct

NTRIP SpiderNet
Direct Dial

(CSD mode)

Name • • • •

IP Address • • •

Port • • •

User Name • •

Password • •

Phone Number •
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Other screens are available from within the Monitor/Skyplot 
function showing the details of the constellation, of the 
base position and of the RTK position solution:

In NTRIP and Direct IP modes, a Disconnect/Connect 
button is available on the Ref tab to easily control the 
network connection. There is also a horizontal bar showing 
the GSM signal level until the modem is on-line. The bar 
disappears when the modem is online.
In Direct Dial mode, a Hang up button is available on the 
same tab to terminate the connection with the base.
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• Tap  after you have made sure the FIXED position 
status is settled. This takes you back to the FAST Survey 
menu from which you can start your survey.
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RTK Surveying

Uploading
Stakeout Points to
the Field Terminal

In your office, do the following:
• Connect the field terminal to your office computer using 

the USB data cable.
• Make sure ActiveSync is installed on your computer and is 

allowed to perform USB connections. If you do not have 
ActiveSync installed, download the latest version from the 
following web page:
hhttp://www.microsoft.com/windowsmobile/activesync/
default.mspx

• Run GNSS Solutions on your office computer.
• Open the project containing the stakeout points you want 

to transfer to the field terminal as your job.
• On the project map view, select all the reference and 

target points making up your job.
• Select Project>Upload Positions to External Device..

• Select RTK Job and FAST Survey data collector.
• Click OK.
• Name the job (e.g. MYJOB). Keep the Selected Targets and 

References option selected and click OK. This opens the 
Data Transfer dialog box.

• In the combo box, select Active Sync and keep Automatic 
transfer enabled.

• Click OK to establish the connection with the field 
terminal and upload the job (to \MyDevice\FAST 
Survey\Data\).

• After the job has been uploaded, turn off the field 
terminal, disconnect the USB cable and go to the field 
with your surveying equipment to stake out your points.

Staking Out Points

1. Run FAST Survey and open the job containing the points 
you want to stake out.

2. Tap on the Survey tab and then select Stake Points. The 
screen now displayed allows you to stake out points.

3. On this screen, FAST Survey asks you to choose the point 
you want to stake out. You can either type in its 
coordinates in the Northing, Easting and Elevation fields, or 
select a pre-defined point from the points list (see File>List 
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Points). You can also define graphically the point by 
tapping on the point on the graphic screen, or define the 
point according to azimuth, slope and horizontal distance.

4. Once you have chosen a point, tap . A graphic screen 
is now displayed to help you head for the point.

Yellow helmet gives
access to Function

Menu!

5. When the distance to the stakeout point is too small to be 
clearly seen on this screen, tap on the surveyor’s helmet 
in the upper-left corner and select Text from the menu that 
pops up.
A new screen appears giving a more accurate view of the 
remaining distance to the stakeout point. (If you want to 

Name of 
stakeout point

Coordinates of 
stakeout point

Provides access to point list.
Example of points list:

Provides access to graphic screen

Next stakeout point

Logs stakeout point

Current status of 
position solution

Name, coordinates of 
stakeout point, quality data, 
deviation data
(Use the up/down arrow 
keys to show/hide this 
information)

Takes you back to the 
point selection screen

Configures general 
case of point logging

Provides access to 
monitor screen

Provides access to 
screen below (Select 
“Text” in menu)

Your current position 
and heading

Stakeout point (target)

GNSS antenna height

Viewing parameters

Zoom settings
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return to the previous screen, just select Graph in the same 
menu.)

When the remaining distance is within the stakeout 
tolerance (this parameter can be changed in 
Equip>Tolerances), markers appear in the four corners of 
the target. You can now set a stake on this point.

6. Tap on the STORE button if you want to store the position 
of this point. You will be notified if the values of HRMS 
and VRMS exceed the tolerances set for these two 
parameters in Equip>Tolerances. A new screen is then 
displayed showing the coordinates of both the staked and 
design points. 

7. Tap  if you agree. The “Point Stored” message appears 
briefly. The screen then comes back to the Stake Points 
screen where you can choose the next point to be staked.

Stakeout point (target)

Provides access to 
previous screen
(Select “Graph” in menu)

Your current position 
and heading

Used to select which 
guidance data to display 
(underneath)

Used to select which 
guidance data to display 
for the point: coordinates 
or quality data

Current status of 
position solution
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8. After staking out all your points, tap  in the upper-
right corner of the screen to return to the menu.

Logging Points 1. Tap on the Survey tab and then on Store Points. The screen 
now displayed allows you to log all your points.
The figure below summarizes all the functions available 
from that screen.

2. Type in the point name and description in the 
corresponding two fields (see above)

3. Tap on the “A” button
4. Enter the number of readings you want before FAST 

Survey is allowed to compute an average position for this 
point.

For example, type in “5” and tap .
Messages follow successively indicating that the system is 
taking the five requested readings. Then FAST Survey 
displays the average coordinates it has determined for the 
point.

5. Tap  if you agree. The “Point Stored” message appears 
briefly. The screen then shows the location of the point 
together with its name and description.

6. After logging all your points, tap  in the upper-right 
corner of the screen to return to the menu.

Configures general 
case of point logging

Provides access to 
monitor screen

Your current position 
and heading

Graphic display area

GNSS antenna height

Viewing parameters
Zoom settings

Logging points with 
position averaging

Logging point 
with offset

Logging point 
(general case)

Enter point name 
and description in 
these two fields

Current position and 
related quality figures
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Downloading RTK
Points to GNSS

Solutions

• Go back to your office and connect the field terminal to 
your office computer using the USB data cable.

• Run GNSS Solutions on your office computer.
• Open the project in which to add the points from the field.
• Select Project>Download Positions from External Device..

• Select RTK Results and FAST Survey data collector.
• Click OK. This opens the Data Transfer dialog box.
• In the combo box, select ActiveSync, enable Automatic 

Transfer and click OK. This opens a new window listing all 
the jobs stored in the field terminal.

• Select the job you want to download (e.g. “MYJOB”) and 
click OK. This starts the download process.

Vector information relative to surveyed points is available only 
in .rw5 files. FAST Survey saves vector information directly in 
this file format and so does not create O-files that would 
contain such information.
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Logging Raw Data

Introduction You can log raw data in two different ways:
• Standalone: You simply need to use the Log button to start 

and stop raw data logging.
Later, you will however need to do the following manually:
1. Downloading phase: Rename the raw data files 

collected on each site.
2. Post-processing phase: Manually correct all computed 

elevations for the antenna height.

• Using FAST Survey: The Survey>Log Raw GPS function 
allows you to fully control raw data logging. Using this 
method offers three advantages:.
1. Antenna reduction is automatically performed during 

post-processing because of the antenna height value 
(from the receiver properties) stored in the raw data 
files.

2. Ability to name the raw data file and insert time tags.
3. Ability to pause/resume data logging.

By default, raw data is logged to the receiver’s internal 
memory.
Using FAST Survey, you can change the storage medium 
(internal memory or USB memory stick).
The choice of storage medium is then valid for both data 
logging methods (standalone and using FAST Survey). If 
“USB memory stick” is selected and no USB stick is 
connected to the receiver, then no data logging will take 
place.
In both data logging methods, the Raw Data Logging icon on 
the General Status screen will start flashing when a raw data 
file is open for logging.

Raw Data Logging
Methods

Standalone
• Press the Log button to start data logging.
• Press the Log button again when it’s time to stop data 

logging.

Using FAST Survey
• Tap Survey>Log Raw GPS.
• Tap Start File.
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• Set the following parameters:
– Elevation Mask in degrees.
– Check the antenna height value. If it’s wrong, tap the 

Change Ant. button to set the new value.
– Storage medium (internal or USB memory stick). 

Choosing the internal memory is recommended. The 
use of a memory stick should be restricted to 
downloading raw data files.

– Logging interval in seconds.

• Tap . This starts data logging. From the screen then 
displayed, you can do the following:
– Name the raw data file, mark a particular point or event 

(Tag New Site). 
– Stop data logging (Close File).
– Access the File Manager window in read-only mode 

(File Manager).
– Continue Logging / Pause Logging. Pausing data logging 

means closing the currently open file. Continuing data 
logging means opening a new file. Data logging will 
start immediately based on the parameters set for the 
previous file. 

Combining the two Methods
Combining the two methods is possible.
For example, you can start data logging using FAST Survey. 
Then you can quit FAST Survey and turn off the field terminal 
without disturbing data logging. Later, you will be allowed to 
stop data logging by simply pressing the Log button on the 
receiver front panel.

Downloading Raw
Data

Use a USB mass storage device as a transit storage medium 
to download raw data files from the receiver’s internal 
memory to your office computer.
Important! During a download operation, files are not deleted 
from the receiver but simply copied to the USB mass storage 
device.
After downloading the files to this device, connect the USB 
device to your computer and use your usual browser to copy 
the files to the project folder.

Using a USB Mass Storage Device
• Connect the USB mass storage device to the receiver via 

the short USB Device cable provided (P/N 702103).
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If raw data files are present in the receiver’s internal 
memory, the following icons will automatically appear on 
the display screen:

• To confirm the file transfer, press the Log button. The 
General status screen will re-appear after the file transfer 
is complete.

• To cancel the file transfer, press the Scroll button.
• If you do not press any button within the next 10 seconds, 

the download procedure will be canceled automatically 
and the screen will come back to the previous display.

Using the USB Cable Provided
• Connect the USB cable provided  (P/N 702104) between 

the office computer and the receiver’s USB port. The 
receiver is then seen as a USB device from the office 
computer

• Using Windows Explorer on your office computer, browse 
the receiver’s internal memory for the raw data files. 

• Copy/paste the files to your project folder. Note  that raw 
data files can directly be deleted from the receiver’s 
internal memory through this connection.

Case of Static Survey in Standalone
When static surveys are performed without the field terminal 
and FAST Survey, you must be careful with raw data file 
names. In view of the ATOM naming conventions used and 
the system’s default settings, there is indeed every chance  
that the base file and the rover file have the same name. It is 
good practice to follow this procedure:
1. Download the raw data file from one of the receivers to the 

USB device.
2. Plug the USB device to the office computer, copy the raw 

data file to the project folder and rename the file to reflect 
the site where the static occupation took place (e.g. 
replace “G____” with “GPREF”)
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3. Repeat the previous two steps with the other receiver, 
using a different name for the file (e.g. replace “G____” 
with “GP100”).

Deleting Raw Data Files

Use FAST Survey to delete raw data files from the receiver 
internal memory.
1. Tap on the Survey tab and then on Log Raw GPS.
2. Tap on File Manager. The screen displays the following 

parameters:
• List of raw data filenames.
• Selected storage medium.
• Free memory available.
• Current number of raw data files in memory.

3. Unless already done, select Internal Mem to list the files 
stored in the internal memory.

4. To delete one file, highlight its name in the list and tap the 
Delete button. To delete all the files, tap Delete All Files.
Important! When the receiver is logging raw data, the file 
being logged cannot be deleted. The file is protected from 
deletion until you close it.
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Base/Rover Configuration Memo

Numbers (#) indicated in the table below refer to those used in the RTK Base 
Configuration and RTK Rover Configuration sections. 

(a) Direct Dial in CSD mode, with GSM modem only.
(b) Base connected to RTDS software through serial line.
(c) Direct IP or NTRIP mode. Third-party base or base network used.
(d) External device used at both the rover and the base to transfer correction data.

Base 
_________________

Rover

#1
Magellan 

Radio

#2
Magellan 

U-Link

#3
Pacific Crest 

Radio

#4
Direct 
Dial

#5
Direct IP via 

GPRS & RTDS

#6
External 
Device

#7
Magellan U-Link • •

#8
PacCrest Radio • • •

#9
Direct Dial • (a)

#10
Direct IP, GPRS • • (b)

#11
Network, GPRS (c)

#12
Network, CDMA (c)

#13
External Device • • • (d)
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C
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C
D
D
D
D
D
D
D

C/DC power supply kit 2
ctive Sync 45, 49
dd new device 27, 30
DVNULLANTENNA 34, 39
larm status 11
larms 6
mbiguity fixing 39
ngle 24
ngle Entry and Display 24
ntenna characteristics 9
ntenna extension 3
ntenna height 34, 39
ntenna reduction 50
UTO 10
uto Dial 36, 41

acklight 6
and 36, 41
ASE 10
attery (external) 17
attery (insert) 16
attery (remove) 15
attery charger 2
attery icon 11
attery model 7
LADE 1
luetooth 8, 24, 26, 33
luetooth identifier 13
luetooth status 12
uzzer 6

arrying case (rigid) 3
hange Ant. 51
hange key 22
hannel 35, 40
harging battery 15
omms tab 25, 38
onfidence level 39
onfigure button 33, 38
oordinate Display Order 24
RD files 23
SD 39

ata link (base) 34
ata link (rover) 39
ata link icon 11
ata transfer screen 14, 52
C power input 7
elete files 53

Delete Receiver 25
Device 33, 38
Device cable (USB) 2, 51
Dial Mode 36
dial Mode 41
Direct Dial 35, 40
Display screen 5
Distance 23
Download positions from external device 49
DSNP 40
DSNP (protocol) 36
E
Elevation mask 34, 39
Equip tab 33, 38
F
Factory settings 9
FAST Survey 1, 22, 23
FEC (Forward Error Correction) 35, 41
Field bag 3
Field terminal 21
Find Receiver 25
Firmware update 9
Firmware version 13
FIXED 10
FLOAT 10
Float 39
G
General Status screen 10, 50
GLONASS 1, 34, 39
GNSS Solutions 45, 49
GPRS 21
GPS base 26
GPS rover 26
GSM antenna 4, 7, 21
GSM module (built-in) 21
GSM status 11
H
Height mark 9
HI measurement tape 2, 9
Host cable (USB) 2
I
Instr 33, 39
IP address 42
K
Key combinations 9
Kinematic 1
L
L1 phase center 9
L2 phase center 9
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LED status (battery charger) 16
Li-ion battery 2
Log button 6
Log Raw GPS 50, 53
Long-range radio link 17
M
Manufacturer 33, 38
Memory screens 12
Model (equipment) 33, 38
N
New outgoing port 28, 29
NTRIP 40
O
O-files 49
OLED 5
Over the Air Baud 35, 41
P
Pac Crest transmitter 3
PacCrest transmitter (connection diagram) 
20
Pages (of information) 6
Passcode 27, 30
Password 42
Pause/resume (data logging) 50, 51
Phone number 42
Pin 36, 41
Position computation screen 13
Post-processed surveys 1
Power button 5
Power LED 5
Power management (internal radio receiver) 
40
Power management (modem) 36, 41
Power status 11
Power-on screen 10
Precision 24
Projection 24
Protocol 35, 40
Provider 36, 41
R
Radio antenna 7, 21
Radio module 7, 21
Radio receiver (internal) 39
Radio receiver kit 4
Radio transmitter 3
Radio transmitter (#800986) 17, 19
Range pole 21
Raw data 6
Raw data icon 11
Readings (number of) 48
Receiver identification screen 13

Receiver parameters 34, 39
Receiver serial number 13
Registering FAST Survey 22
Repeater 3
RTDS Software 34
RW5 files 49
S
s 33
Satellites in use 11
Saving registration code 23
SBAS 1, 34, 39
Scrambling 35, 41
Screen backlight 14
Scroll button 5, 6, 10
Secured connection 28
Serial port 8
Serial port service 27, 31
Set Receiver Name 25, 38
Set Receiver PIN 25
SIM card 21
Slant 34
Slant measurement 9
SpiderNet 40
Squelch 40
Stake out 45
Stake points 45
Standalone (raw data logging) 50
Status (position) 10
Stop&Go 1, 51
Storage medium 50
Store points 48
T
Tag New Site 51
Tagging 50
TCP/IP Direct 35, 40
Tribrach 17
Tripod 17
U
UDP/IP Direct 35, 40
U-Link 17
U-Link receiver modules (U-link Rx) 4
U-Link transmitter 18
U-Link TRx 3
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